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1. Введение 

SelTag – это один из наиболее совершенных инструментов, 
предназначенных для анализа данных экспрессии генов. С его помощью можно 
анализировать все или выделенные группы генов или тканей; выделять, 
основываясь на комплексных критериях, тканеспецифичные гены; получать 
визуальное представление данных экспрессии; идентифицировать гены, 
коррелированно экспрессирующиеся в данном наборе тканей; выделять 
болезнеспецифичные гены с определенными характеристиками, такие как 
рецепторы или секретируемые белки. 

2. Общее описание системы  
2.1. Главное окно 

Главное окно предназначено для отображения экспрессии генов в виде 
таблицы. В верхней части окна расположены команды главного меню.  

2.2. Описание команд главного меню 
1. Меню "File" – предоставляет набор команд для работы с файлами: 
• “Open data” – вызывает диалоговое окно «Load data», предназначенное для  

загрузки файла с таблицей экспрессии генов из проекта. 
• “Upload data” – вызывает диалоговое окно «Upload file», предназначенное для 

добавления нового файла в проект с рабочей станции. 
• ”Save” – в данной версии команда неактивна. 
• “Save as” – в данной версии команда неактивна. 
• “Close” – выгрузить рабочие данные. 
• “New project” – создать новый проект.  
• “Open project” – вызывает диалоговое окно «Open project», предназначенное 

для загрузки имеющихся проектов по идентификатору. 
• “Delete project” – удалить проект. Вызывает диалоговое окно “Delete projects”, 

предназначенное для удаления проектов. 
• “Close project” – закрыть проект. 
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• “Link gene data” – загрузить файл с описанием генов. Вызывает диалоговое 
окно “Load data”, предназначенное для загрузки файла с описанием генов. 
После загрузки файла с описанием генов становится активной команда 
View>Gene description главного меню. 

• “Save gene data” – в данной версии команда неактивна. 
• “Unlink gene data” – выгрузить файл с описанием генов. 
• "Exit" - выход из программы. 
 
2. Меню “Edit” – предоставляет набор команд для быстрого поиска генов в 
таблице. 
• “Quick search gene” – вызывает диалоговое окно «Quick search», 

предназначенное для поиска гена в таблице по значению поля. 
 
3. Меню “View” – предоставляет набор команд для просмотра матрицы экспрессии 
и информации о генах: 

• "Image” - вызывает диаграмму отображения матрицы экспрессии.   
• “Project information” – вызывает диалоговое окно «Project information», 

предназначенное для просмотра информации о проекте (идентификаторы 
активного проекта и активного файла).  

• “Gene description” – активизирует панель с описанием генов. Команда 
активна, если загружен файл с описанием генов. 

 
4. Меню “Select” – предоставляет набор команд для работы с таблицами:  
• “Select genes by query…” – вызывает диалоговое окно «make selection», 

которое позволяет выбрать из рабочей таблицы гены, удовлетворяющие 
определенным условиям, и формирует из них новую таблицу.  

• “Initial data” – вызывает главную таблицу (таблицу, содержащую полный список 
генов, загруженных в начале работы с проектом) экспрессии генов. 

• “Remove all selections” – закрывает все таблицы, полученные в результате 
выполнения каких-либо операций селекции. 

 
5. Меню “Group” – предоставляет набор команд для операций над группами 
экспериментов: 
• “View” – вызывает диалоговое окно «view group data», предназначенное для 

просмотра групп. 
• “Add” - вызывает диалоговое окно «edit group data», предназначенное для 

создания групп. 
• “Edit” - вызывает диалоговое окно «select field group», позволяющее выбрать 

одну из групп для редактирования, а затем вызывает диалоговое окно 
редактирования этой группы. 

• “Load” – в данной версии команда неактивна. 
• “Save” – в данной версии команда неактивна. 
• “Delete” - вызывает диалоговое окно «select field group», позволяющее выбрать 

одну (или несколько) групп для удаления, и затем удаляет их. 
 
6. Меню “Analysis” – предоставляет набор команд, предназначенных для анализа 
данных:  
• “Correlations”: 

• “Select most correlated genes” - вызывает диалоговое окно «select most 
correlated genes for specified gene set», предназначенное для поиска 
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генов, имеющих наибольшую корреляцию профилей экспрессии с одним 
или несколькими генами. 

• “Get correlations between genes” - вызывает диалоговое окно «correlation 
analysis setup», предназначенное для вычисления корреляционной 
матрицы между двумя наборами генов. 

• “Get correlations between fields” – вызывает диалоговое окно «correlation 
analysis setup», предназначенное для вычисления корреляционной 
матрицы между двумя наборами полей. 

• “Clustering”: 
• “Build tree for genes” - вызывает диалоговое окно «tree calculation setup», 

предназначенное для построения дерева генов. 
• “Find gene’s clustering” - вызывает диалоговое окно «setup for clustering 

procedure», предназначенное для задания значений параметрам запроса 
кластеризации генов. 

• “Build tree for fields” - вызывает диалоговое окно «tree calculation setup», 
предназначенное для построения дерева полей. 

• “Load tree” - в данной версии команда неактивна. 
• “Principal component” - вызывает диалоговое окно «setup for principal component 

analysis», предназначенное для анализа корреляционной или ковариационной 
матрицы профилей экспрессии генов методом главных компонент и 
визуализации полученных результатов. 

 
7. Меню “Graph” - содержит набор команд для графического отображения 
профилей экспрессии генов:  
• “Specified with current selection” - вызывает диалоговое окно «Profile dialog», 

предназначенное для графического отображения профилей генов из активной 
таблицы. 

 
8. Меню “Help” – вызов справки о программе.   
 

2.3. Формат файла с таблицей экспрессии генов 
Данные экспрессии для набора генов представляются в виде таблицы, 

состоящей из рядов/строк (или генов) и столбцов (полей). Каждая строка таблицы 
соответствует набору данных для одного гена. Наборы данных для всех генов 
(строк) являются одинаковыми. Как правило, столбцы соответствуют измерениям 
экспрессии генов в различных условиях (тканях, органах, клеточных культурах и 
т.п.). Кроме того, часть столбцов может включать другую информацию (как 
численную, так и текстовую), связанную с генами, например их название.  
В общем виде столбцы таблицы (поля) могут быть 4 основных видов: 
 

IVALUE - значение – целое число 
FVALUE - значение – число с плавающей точкой 
WORD - значение – текст без пробелов внутри (слово) 
STRING - значение – строка (текст с пробелами) 

 
Поля полностью определяются типом и именем. 
 

Основной формат входящего файла SelTag 
Основной формат входящего файла должен быть следующим: 

 
; May contain comment in any line of the file 
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NAME<tab>WORD 
GENEID<tab>IVALUE 
TISSUECANCER0<tab>FVALUE 
TISSUECANCER1<tab>FVALUE 
TISSUENORMAL0<tab>FVALUE 
TISSUENORMAL1<tab>FVALUE 
TISSUENORMAL2<tab>FVALUE 
DATA 
GENE04675<tab>402<tab>6.00<tab>5.60<tab>5.97<tab>6.00<tab>6.00 
GENE46890<tab>794<tab>2.77<tab>3.22<tab>5.65<tab>5.68<tab>5.68 
GENE23794<tab>404<tab>5.97<tab>5.97<tab>6.00<tab>5.60<tab>5.97 
 
В этом примере <tab> означает символ табуляции (клавиша ‘Tab’) 

Первые строки (над строкой "DATA") содержат описание формата данных. В 
этой части файла каждая строка содержит описание поля: имя поля и основной 
тип поля. 

Строки, идущие после строки "DATA", содержат данные экспрессии для 
каждого гена. Каждая строка соответствует отдельному гену. Данные полей 
разделяются символом табуляции. Двойной символ табуляции означает 
пропущенные данные. 
 

Группы полей. 
Поля одного типа могут быть объединены в группу полей. Группа может 

быть определена списком соответствующих полей и именем. В целом, это 
объединение может отражать функциональную значимость этих полей. Например, 
поля, представляющие уровни экспрессии в раковых тканях, могут быть 
объединены в группу “Cancer tissues”. Одно и то же поле может быть включено в 
несколько групп полей, т.е. наборы полей в группах могут перекрываться. 
 Описание формата может включать в себя описание группы полей. Оно 
начинается со строки "#GROUP", в которой определяется имя группы. Затем идут 
строки, содержащие список полей, входящих в данную группу. Описание группы 
должно заканчиваться строкой “#ENDGROUP”.    
 
Пример формата данных, в котором определены поля.  
 
; May contain comment in any line of the file 
NAME<tab>WORD 
GENEID<tab>IVALUE 
TISSUECANCER0<tab>FVALUE 
TISSUECANCER1<tab>FVALUE 
TISSUENORMAL0<tab>FVALUE 
TISSUENORMAL1<tab>FVALUE 
TISSUENORMAL2<tab>FVALUE 
#GROUP<tab>Cancer tissues 
TISSUECANCER0 
TISSUECANCER1 
#ENDGROUP 
#GROUP<tab>Arbitrary group 
TISSUECANCER1 
TISSUECANCER2 
TISSUENORMAL0 
TISSUENORMAL1 
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#ENDGROUP 
DATA 
GENE04675<tab>402<tab>6.00<tab>5.60<tab>5.97<tab>6.00<tab>6.00 
GENE46890<tab>794<tab>2.77<tab>3.22<tab>5.65<tab>5.68<tab>5.68 
GENE23794<tab>404<tab>5.97<tab>5.97<tab>6.00<tab>5.60<tab>5.97 
 
В этом формате данных определены две группы, "Cancer tissues" (включает поля  
TISSUECANCER0, TISSUECANCER1) и "Arbitrary group" (включает поля  
TISSUECANCER1 TISSUECANCER2 TISSUENORMAL0 TISSUENORMAL1). 
 

Данные могут быть загружены в программу Seltag из файлов имеющих 
более простой формат таблиц, а так же могут быть извлечены их набора таблиц, 
имеющих сходный порядок и набор столбцов.  
 

2.4. Формат файла с описанием генов 
 Файл типа "Gene Description" состоит из нескольких идущих подряд 
описаний. Каждое описание занимает одну или более строк. 
Первая строка имеет вид: 
">" Id "|" Short_description 
Где ID - это некий идентификатор для связи с данными, 
Short_description - краткое описание в одну строку. 
 
После первой строки может присутствовать несколько строк с URL_description, 
далее может быть несколько строк Long_description. 
 
URL_description - это одна строка вида: 
"URL:" Menu_text "|" URL 
Menu_text - это текстовое описание для URL 
URL - это обычный URL, то есть строка "http://.../..." 
 
Long_description - это те несколько строк, которые содержат длинное 
многострочное описание. 
 

3. Описание работы с системой  
3.1. Выбор генов по запросу 

 Диалоговое окно «make selection» вызывается командой Select>Select genes 
by query…. Позволяет выбирать гены из рабочей таблицы по выражению. Окно 
содержит следующие элементы: 
 3.1.1. Строка выражения - это  редактируемое текстовое поле, 
расположенное в верхней части окна. Кнопка «Clear Expr.» очищает его 
содержимое. 
 3.1.2. Строка статуса (комментариев) располагается под строкой запроса. 
Это текстовое поле, в котором отображается вспомогательная информация. 
 3.1.3. Панель «Field» - панель ввода индекса поля, содержит 
выпадающий список полей. Список вызывается кнопкой “Select”. Поля 
представлены в формате: 

Fn NAME, где n-порядковый номер поля, NAME - его название.  
При выборе поля в строке статуса отображается следующая информация: 
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$Fn: type=FIELDTYPE. Is item of group(s):x, где n-порядковый номер поля, 
FIELDTYPE - название типа данных поля, х - если поле входит в какие-либо 
группы, то перечисляются их порядковые номера.  
Кнопка «Insert» добавляет в выражение текущее значение $Fn, где n-порядковый 
номер поля.  
 3.1.4. Панель выбора значений текстовых полей cодержит: 

• Список значений текстовых полей служит для выбора значений строкового 
типа. Данный список активируется, тип выбранного поля является 
строковым. Если тип поля не является строковым (не WORD и не STRING), 
то данный список не заполняется. 

• Список текстовых полей вызывается кнопкой “Select”. 
• Кнопка «Insert» добавляет в выражение выбранное значение из списка 

текущих элементов в формате "TEXT".  
•  

 3.1.5. Панель «Group» - панель ввода порядкового номера группы. 
Содержит: 

• 3.1.5.1. Список групп «Group» содержит список групп экспериментов. Список 
вызывается кнопкой “Select”. Группы представлены в формате: 
   Gn NAME, где n-порядковый номер группы, NAME - ее название. При 
выборе поля в строке статуса 3.1.2 отображается следующая информация: 
   $Gn: type=FIELDTYPE, fields[x]: y1,y2,y3.....  
   где n - порядковый номер группы, FIELDTYPE - название типа данных 
этой группы, х - число полей, входящих в группу, 
   у1,у2... - порядковые номера полей, входящих в группу. 

• 3.1.5.2. Поле «Input condition level» - поле дополнительного условия. 
Накладывает дополнительное условие на выборку по группе. Эти условия 
определяют нижний порог для числа экспериментов в группе, для которых 
условие должно быть выполнено. Этот порог может быть записан в виде 
числа экспериментов (в этом случае в данное поле вводится целое число) 
или их процентной доли в группе (в этом случае указывается процентная 
доля X в формате X%). 

• 3.1.5.3. Кнопка «Insert» добавляет в выражение текущее значение $Gn, где 
n-порядковый номер поля. 

Если заполнены дополнительные условия, то они добавляются в выражение: 
$Gn:50% 
 3.1.6. Панель «Card No.» - панель ввода спецификатора порядкового 
номера гена в таблице. Кнопка «Insert» добавляет в строку выражения значение 
$N. 
 3.1.7. Кнопки управления диалоговым окном: 

• «Cancel» - отказ и выход без построения новой таблицы. 
• «Scan» - выполнение запроса по выражению. После выполнения запроса в 

строке статуса выводится информация о количестве отобранных генов. 
• «OK» - выход из диалогового окна с принятием результатов запроса и 

построением новой таблицы генов. 
 
3.1.8. Кнопки ввода запроса добавляют в выражение лексемы: операции, 
цифры, математические функции.  
  
3.1.9. Панель «Expr. Score options» содержит: 

• Флаг «Calculate scores for last selection». Если флаг установлен, появляется 
список выбранных по последнему запросу генов и их весов. 

• Поле со списком генов и их весами. 
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Выпадающий список «Type» и поле «Value» предназначены для дополнительного 
выбора генов по весу. Список «Type» содержит два типа выборки:  

• "Not applied" - при нажатии кнопки «OK» будут отобраны все гены, 
удовлетворяющие условию запроса. 

• "Best N" - при нажатии кнопки «OK» будут отобраны только гены, 
имеющие наибольшие веса. Количество генов задается в поле 
«Value». 

 
После выполнения запроса в меню главного окна «Select» появляется 

дополнительный пункт, имя которого соответствует выбранному набору генов 
(номеру запроса + выражение). Пользователь в ходе работы может сохранять 
полученные выборки генов или переключаться между ними. Для удаления списка 
таблиц используется опция меню «Remove all selections». 

3.2. Работа с группами полей (экспериментов) 
Работа с группами полей осуществляется через команды меню «Group». 

1. Команда Group>View вызывает диалоговое окно просмотра групп «view 
group data». В списке «Group list» отображаются группы; в списке «Group 
Fields» отображаются поля, содержащиеся в выбранной группе. Над 
списками выводится информация об общем количестве групп и количестве 
непересекающихся полей в проекте. Кнопка «OK» служит для выхода из 
окна.  

2. Команда Group>Add вызывает диалоговое окно «edit group data», 
предназначенное для добавления новых групп в проект. Для того чтобы 
создать новую группу, необходимо: 

a. Выбрать типы полей с помощью радиокнопок на панели «Select field 
types». Поля выбранного типа появятся в списке «Data fields». Для 
добавления полей в группу служит кнопка «Add», для удаления -  
кнопка «Remove». 

b. Ввести название группы (например, NewGroup) в поле «Group Name». 
Если установлен флаг «Simultaneously add inverted group», будут 
созданы две группы с названиями NewGroup и INV_NewGroup (в 
которую включаются поля, не вошедшие в группу NewGroup). 

c. Нажать кнопку «Save group». Кнопка «Cancel» служит для отмены. 
Если название вновь созданной группы совпадает с уже имеющимися 
названиями групп, то кнопки «Save group» и “Cancel” становятся 
неактивными. 

3. Команда Group>Edit вызывает диалоговое окно «Select field group», в 
котором нужно выбрать редактируемую группу. После нажатия кнопки «OK»  
появится диалоговое окно «edit group data», с помощью которого можно: 

a.  Изменить список полей, входящих в группу (отображается в списке 
«Group Fields»). Для добавления полей в группу служит кнопка «Add», 
для удаления -  кнопка «Remove». 

b. Изменить имя группы. Для этого нужно изменить имя группы в поле 
«Group Name».  

c. Создать «инвертированную группу» (в ее состав войдут поля, 
содержащиеся в списке «Data fields», в название группы добавляется 
префикс «INV_»). Для этого требуется установить флаг 
«Simultaneously add inverted group». Если «инвертированная группа» 
с таким названием уже существует, ее содержимое обновится с 
учетом сделанных изменений. 
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Кнопка «Save group» служит для подтверждения изменений, кнопка 
«Cancel» - для отмены изменений. 

4. Команда Group>Delete вызывает диалоговое окно «Select field group», в 
котором можно удалить группу из проекта. Для этого нужно в списке мышью 
выделить группу и нажать кнопку «Delete». Для подтверждения изменений 
служит кнопка «OK», для отмены – «Cancel». 

 

3.3. Диалоговое окно выбора полей 
Диалоговое окно выбора полей вызывается нажатием кнопки «Fields…» в 

диалоговых окнах «Select most correlated genes for specified gene set», «correlation 
analysis setup», «Tree calculation setup», «setup for clustering procedure», «setup for  
principal component analysis», а также командой Graph>specified with current 
selection (в случае отсутствия групп). Оно служит для выбора полей из главной 
таблицы.  

3.3.1. Список типов данных 
Список активируется, если установлен флаг «Field types filtering». В списке 

отображаются имена типов данных: WORD, IVALUE, STRING, FVALUE. 
Выделенные в списке типы задают фильтр на поля и группы проекта. 

Если флаг «Field types filtering» не установлен, то список неактивен, а в 
списке групп и списке полей появляются группы и поля всех типов данных. 

3.3.2. Список групп полей экспериментов 
 Список активируется, если установлен флаг «Field groups filtering». В списке 
содержатся имена групп. Выделенные в списке группы задают фильтр на поля 
(экспериментов). 

Кнопки управления списком: 
•  «Select all» - при нажатии выделяет все группы. 
• «Invert selection» - при нажатии инвертирует список. 
• «Unselect all» - при нажатии отменяет выделение всех групп. 
Если установлен флаг «Field types filtering», в списке 3.3.2 содержатся группы, 

типы которых соответствуют выделенным в списке 3.3.1. Если флаг «Field types 
filtering» не установлен, в списке 3.3.2 содержатся все группы. 

3.3.3. Список полей 
 Данный список располагается на панели «Fields». В этом списке 
содержатся поля, удовлетворяющие ограничениям, установленным в списках 
3.3.1 и 3.3.2. Если ограничений нет, в списке содержатся все поля. Кнопки 
управления списком: 

• «Select all» - при нажатии выделяет все поля. 
• «Invert selection» - при нажатии инвертирует список. 
• «Unselect all» - при нажатии отменяет выделение всех полей. 
• «Select all experiments» - выделяет все поля, которые являются 

измерениями экспрессии. 
3.3.4. Кнопки управления диалоговым окном 

• «Cancel» - выход без выбора. 
• «OK» - выбор полей, которые выделены в списке 3.3.3. 
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3.4. Выбор генов с наибольшей корреляцией профилей 
экспрессии 

Команда Analysis>Correlations>Select most correlated genes вызывает 
диалоговое окно «Select most correlated genes for specified gene set», 
предназначенное для задания значений параметрам выборки. 

3.4.1. Список выбора генов расположен под меткой «Gene list to select 
from». Содержит гены из текущей таблицы. Над списком расположено текстовое 
поле, предназначенное для выделения строк по маске. В маске знак «%» 
заменяет собой один символ, знак «*» - несколько символов. 

3.4.2. Список выбранных генов расположен под меткой «Specified genes 
(query set to compare with)». Содержит гены, выбранные из списка 3.4.1. Над 
списком расположено текстовое поле, предназначенное для выделения строк по 
маске. В маске знак «%» заменяет собой один символ, знак «*» - несколько 
символов. 

Из списка 3.4.1 выбирается поднабор генов (набор 2), который может 
состоять из одного или более генов. Набор 2 отображается в списке 3.4.2. Гены, 
оставшиеся в списке 3.4.1, формируют набор 1. Наборы 1 и 2 не имеют общих 
генов. 

3.4.3. Кнопки управления списками 
«AddÆ» - переместить гены, выделенные в списке 1 в список 2. 
«AllÆ» - переместить все гены из списка 1 в список 2. 
«ÅRemove» - переместить гены, выделенные в списке 2 в список 1. 
«ÅAll» - переместить все гены списка 2 в список 1. 
«File loadÆ» - загрузить список 2 из файла. В данной версии кнопка неактивна. 

Программа выбирает из набора 1 гены, имеющие наибольшие корреляции 
профилей экспрессии с генами из набора 2. При выходе строятся профили 
экспрессии выбранных генов, а коэффициенты корреляции заносятся в отдельную 
таблицу.  

3.4.4. Флаг «Initial gene set». Если флаг установлен, то в список 1 
помещаются гены из главной таблицы. 
 

Задание параметров расчета 
3.4.5. Кнопка «Fields...» вызывает диалоговое окно выбора полей 3.3. 

Текстовое поле отображает количество выбранных полей.  
3.4.6. Список «Correlation type» содержит три типа коэффициентов 

корреляции:  
• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла.  

3.4.7. Список «Threshold type» содержит 4 типа ограничений на выбор генов: 
• «Best N» – выбор N наилучших по значению корреляции генов из 

набора 1 (N указывается в поле «and value»). 
• «Best %» - выбор доли (%) лучших по значению корреляции генов из 

набора 1 (доля в % указывается в поле «and value»). 
• «Value» – выбор генов из набора 1, имеющих значение корреляции 

равные или выше указанного порога по абсолютному значению 
(значение порога указывается в поле «value»). 

• «All» – выбор всех генов из списка 1. 
3.4.8. Поле установки значения порога корреляции «value». В нем 

указывается значение ограничения (см п. 3.4.7). 
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3.4.9. Список «Regime to treat multiple genes for query set» содержит три 
режима определения корреляции:  

• Режим "Max. correlation value to select" - при сравнении генов из набора 1 
определяющим параметром является максимальное значение 
коэффициента корреляции гена из набора 1 с генами из набора 2. 

• Режим "Aver. correlation value to select " - при сравнении генов из набора 1 
определяющим параметром является среднее значение коэффициента 
корреляции гена из набора 1 с генами из набора 2.  

• Режим "Corr for aver field values to select" - при сравнении генов из набора 1 
определяющим параметром является значение коэффициента корреляции 
гена из набора 1 со средним профилем генов из набора 2. Т.е. вычисляется 
"фиктивный ген" со средними значениями полей из набора 2 и с ним 
считается коэффициент корреляции. 
3.4.10. Опции сохранения данных в файле в данной версии неактивны. 
3.4.11. История списков 2 в данной версии неактивна. 

 
3.4.12. Параметры вывода данных 
• Флаг «View corr. matrix in separate window». Если флаг установлен, то 

коэффициенты корреляции выводятся в дополнительном окне (описание 
работы с диалоговым окном матрицы корреляции см в п.3.7). В матрице строки 
соответствуют выбранным из списка 1 генам, расположенным в порядке 
уменьшения коэффициента корреляции с набором 2. Первая колонка - их 
идентификаторы. Вторая колонка - коэффициент корреляции, по которому был 
произведен отбор (согласно режиму отбора). Остальные колонки содержат 
коэффициенты корреляции с генами из набора 2.  

3.4.13. Кнопки управления диалоговым окном 
• «Cancel»- выход без выполнения операции 
• «ОК» - выполнение функции. После нажатия этой кнопки запускается 

диалоговое окно «Profile dialog», в списке групп экспериментов которого 
появляется группа «group from SelCorr +N0 », содержащая эксперименты, по 
которым производилась операция. 

 
3.5. Задание параметров запроса коэффициентов корреляции 

между профилями генов 
 Диалоговое окно «correlation analysis setup», предназначенное для задания 
значений параметрам вычисления корреляционной матрицы между двумя 
наборами генов, вызывается командой 
Analysis>Correlations>Get correlations between genes.  
 Из полного набора генов выбирается два поднабора (набор 1, 
соответствующий строкам матрицы корреляции, набор 2, соответствующий 
столбцам матрицы корреляции). Эти наборы генов могут пересекаться. Между 
профилями экспрессии генов из этих наборов вычисляются парные 
коэффициенты корреляции. В результате образуется корреляционая матрица 
размером n*m (n строк, m столбцов). Элемент матрицы (i,j) соответствует 
коэффициенту корреляции профилей экспрессии i-го гена из набора 1 и j-го гена 
из набора 2. 
 3.5.1. Список «Set 1 (raws)» содержит гены, из которых будет сформирован 
набор 1.  

3.5.2. Список «Set 2 (columns)» содержит гены, из которых будет 
сформирован набор 2.  
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3.5.3. Кнопка «Fields...» вызывает диалоговое окно выбора полей 3.3. 
Текстовое поле отображает количество выбранных полей.  

3.5.4. Список «Correlation type» содержит три типа коэффициентов 
корреляции:  

• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла.  

3.5.5. Список выбора порога коэффициента корреляции «Threshold type». 
Элементы матрицы, превышающие данный порог показываются красным цветом. 
Список содержит 4 типа порога на коэффициент корреляции: 

• «Best N» – выбор N наибольших коэффициентов корреляции (N 
указывается в поле «Value»). 

• «Best %» - выбор доли (%) наибольших коэффициентов корреляции 
(доля в % указывается в поле «Value»). 

• «Value» – выбор коэффициентов корреляции, имеющих значение 
равные или выше указанного порога (значение порога указывается в 
поле «Value»). 

• «All» – выбор всех генов из списка 1. 
3.5.6. Поле установки значения порога корреляции «Value». В нем 

указывается значение ограничения (см п. 3.4.5). 
3.5.7. Кнопки управления диалоговым окном 

• «Cancel»- выход без выполнения операции 
• «ОК» - выполнение функции. В диалоговом окне «Correlation matrix dialog» 

выводится матрица корреляции (описание работы с диалоговым окном 
матрицы корреляции см в п.3.7). 

3.6. Поиск корреляции между двумя наборами полей. 
 Команда Analysis>Correlations>Get correlations between fields вызывает 
диалоговое окно «correlation analysis setup», предназначенное для задания 
значений параметрам вычисления корреляционной матрицы между двумя 
наборами полей.  
 3.6.1. Флаг «ITYPE». Если флаг установлен, в списки 3.6.3 и 3.6.4 
включаются поля, принадлежащие к типу данных ITYPE. 

3.6.2. Флаг «FTYPE» Если флаг установлен, в списки 3.6.3 и 3.6.4 
включаются поля, принадлежащие к типу данных FTYPE. 
3.6.3. Список «Field set 1 (raws)» содержит поля, из которых будет 

сформирован набор 1. Кнопкой «Mark all tissues in set 1» можно выделить все поля 
списка. 

3.6.4. Список «Field set 2 (columns)» содержит поля, из которых будет 
сформирован набор 2. Кнопкой «Mark all tissues in set 2» можно выделить все поля 
списка. 

3.6.5. Список «Correlation type» содержит три типа коэффициентов 
корреляции:  

• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла.  

3.6.6. Список выбора порога коэффициента корреляции «Type». Элементы 
матрицы, превышающие данный порог показываются красным цветом. Список 
содержит 4 типа порога на коэффициент корреляции: 

• «Best N» – выбор N наибольших коэффициентов корреляции (N 
указывается в поле «Value»). 
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• «Best %» - выбор доли (%) наибольших коэффициентов корреляции 
(доля в % указывается в поле «Value»). 

• «Value» – выбор коэффициентов корреляции, имеющих значение 
равные или выше указанного порога (значение порога указывается в 
поле «Value»). 

• «All» – выбор всех генов из списка 1. 
3.6.7. Поле задания значения порога корреляции «Value». В нем 

указывается значение ограничения (см п. 3.6.6.). 
3.6.8. Кнопки управления диалоговым окном 

• «Cancel»- выход без выполнения операции 
• «ОК» - выполнение операции. В диалоговом окне «Correlation matrix dialog» 

выводится матрица корреляции (описание работы с диалоговым окном 
матрицы корреляции см в п. 3.7). 

3.7. Диалоговое окно матрицы корреляции 
Диалоговое окно матрицы корреляции  «Correlation matrix dialog» 

вызывается при работе с диалоговыми окнами «Select most correlated genes for 
specified gene set» (если установлен флаг 3.4.12) и  «correlation analysis setup». 
1. Меню «File» – предоставляет набор команд для работы с файлами: 

• Save matrix – в данной версии неактивна. 
• Save row genes – в данной версии неактивна. 
• Close – закрыть диалоговое окно. 

2. Меню «Action» – предоставляет набор команд для операций над матрицей. 
• Sort rows – вызывает диалоговое окно «sort matrix rows», предназначенное 

для сортировки строк данных. 
• Graph>Line plot – вызывает диалоговое окно «setup for correlations graph», 

предназначенное для построения профилей значений матрицы корреляции. 
   
3.7.1. Диалоговое окно «sort matrix rows» служит для задания параметров 
сортировки строк данных. 
3.7.1.1. «Regime to get sorting values from row data» – режим сортировки значений 
строк данных: 

• «Max. correlation value to select» – определяющим параметром является 
максимальное значение корреляции. 

• «Aver. correlation value to select» – определяющим параметром является 
среднее значение корреляции. 

3.7.1.2. «Order» – порядок сортировки: 
• «Descending» – по убыванию 
• «Ascending» – по возрастанию 

3.7.1.2. «Sign operation» - сортировка с учетом знака значения: 
• «Not applied» –  не сортировать 
• «ABS» –  по абсолютному значению 
• «Negative» – по отрицательному значению 

3.7.1.3. Кнопки управления диалоговым окном 
• «Cancel» - выход без сортировки. 
• «OK» - сортировка по заданным параметрам. 

 
3.7.2. Диалоговое окно «setup for correlations graph» служит для задания 
параметров графического отображения матрицы корреляции в диалоговом окне 
«Profile dialog» (работу с окном см в п.3.13): 
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 3.7.2.1. Список «Set 1 (rows)» содержит гены, из которых будет 
сформирован набор 1. 
 3.7.2.2. Список «Set 2 (columns)» содержит гены, из которых будет 
сформирован набор 2. 
 3.7.2.3. «Select X-Y axis representation» - режим выбора осей координат: 

«X = rows (Set1), Graphs=columns (Set2)» –  по оси Х находятся гены из 
набора 1, по оси Y (и в списке генов) – гены из набора 2. 

«X = columns (Set2), Graphs=rows (Set1)» –  по оси Х находятся гены из 
набора 2, по оси Y (и в списке генов) – гены из набора 1. 
  3.7.2.4. Кнопки управления диалоговым окном 

• «Cancel» - выход без построения графика. 
• «OK» - вызов диалогового окна «Profile dialog» с заданными параметрами 

отображения. 

3.8. Построение дерева генов 
Команда Analysis>Clustering>Build tree for genes вызывает диалоговое окно 

«Tree calculation setup», предназначенное для задания значений параметрам 
построения дерева генов по текущей таблице. 

3.8.1. Кнопка «Fields...» вызывает диалоговое окно выбора полей 3.3. 
Текстовое поле отображает количество выбранных полей. 

3.8.2. Список «Correlation type» содержит три типа коэффициентов 
корреляции:  

• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла. 

3.8.3. Список «Distance type» содержит три типа мер расстояний, которые 
вычисляются на основе коэффициентов корреляции Rij:  

• 1-Rij  
• 1+Rij  
• 1-|Rij| 

3.8.4. Список «Amalgamation rule» содержит 4 типа объединения узлов 
дерева:  

• UPGMA  
• Nearest neighbour  
• Furthest neighbour  
• WPGMA 

3.8.5. Список «Data subset» содержит поднаборы генов для построения 
дерева: 

• all genes – все гены из текущей таблицы. 
3.8.6. Флаг «Create expr. image». Если флаг установлен, то после 

вычисления появляется диаграмма матрицы экспрессии.  
3.8.7. Флаг «Make tree for fields». Если флаг установлен, то вычисляется 

дерево сходства между значениями экспериментов в матрице экспрессии и при 
отображении диаграммы экспрессии порядок экспериментов определяется 
деревом полей.  

3.8.8. Опции сохранения данных в файле в данной версии неактивны. 
3.8.9. Кнопки управления диалоговым окном 

• «Cancel»- выход без выполнения операции 
• «ОК» - выполнение операции построения дерева и вызов диалога 

отображения дерева в виде диаграммы (описание работы с диалогом см в 
п. 3.10). 
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3.9. Построение дерева полей 
Команда Analysis>Clustering>Build tree for fields вызывает диалоговое окно 

«Tree calculation setup», предназначенное для задания параметрам построения 
дерева полей по текущей таблице. 

3.9.1. Кнопка «Fields...» вызывает диалоговое окно выбора полей 3.3. 
Текстовое поле отображает количество выбранных полей. 

3.9.2. Список «Correlation type» содержит три типа коэффициентов 
корреляции:  

• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла. 

3.9.3. Список «Distance type» содержит три типа мер расстояний, которые 
вычисляются на основе коэффициентов корреляции Rij:  

• 1-Rij  
• 1+Rij  
• 1-|Rij| 

3.9.4. Список «Amalgamation rule» содержит 4 типа объединения узлов 
дерева:  

• UPGMA  
• Nearest neighbour  
• Furthest neighbour  
• WPGMA 

3.9.5. Опции сохранения данных в файле в данной версии неактивны. 
3.9.6. Кнопки управления диалоговым окном 

• «Cancel»- выход без выполнения операции 
• «ОК» - выполнение операции построения дерева и вызов диалога 

отображения дерева в виде диаграммы (описание работы с диалогом см в 
п. 3.10). 

3.10. Диалоговое окно отображения дерева в виде диаграммы 
Диалоговое окно «Tree Diagram» вызывается после выполнения команды 
построения дерева (в диалоговых окнах «Tree calculation setup») и служит для 
отображения дерева в виде диаграммы.  
Команды главного меню: 

• «File» – в данной версии команда неактивна.  
• «Edit» – предоставляет набор команд для настроек режимов работы с 

диаграммой дерева.  
o Mark – команды выделения: 

� Mark nodes – вызывает диалоговое окно «find node setup», 
предназначенное для задания параметров выделения узлов. В 
данной версии окно неактивно. 

� Unmark all – отменить выделение всех узлов. 
o Mouse mode – выбор режимов работы мыши: 

� Mark nodes – режим выделения узлов. 
� Swap child nodes – режим перемещения дочерних узлов. 
� Marking all descent nodes – режим выделения дочерних узлов. 

o Options – вызывает диалоговое окно настроек «tree options». 
• «Marked leaves…» – в данной версии команда неактивна.  
• «Image» – предоставляет набор команд для настроек режимов работы с 

диаграммой матрицы экспрессии. 
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o «View expr. image» – если установлен флаг, добавляется диаграмма 
отображения матрицы экспрессии. 

o «Image setup» – вызывает диалоговое окно настроек отображения 
матрицы экспрессии “pattern setup”.  

o «Column data subset» – в данной версии команда неактивна. 
 
Кнопки панели управления: 

 «Nodes marking» - вызывает режим выделения узлов. Действует аналогично 
команде Edit>Mouse mode>Mark nodes главного меню. 

 «Child nodes swapping» - вызывает режим перемещения дочерних узлов. 
Действует аналогично команде Edit>Mouse mode>Swap child nodes главного меню. 

 «Marking of all descent nodes» - вызывает режим выделения дочерних узлов. 
Действует аналогично команде Edit>Mouse mode>Marking all descent nodes 
главного меню. 

 «Unselect all» - отменить выделение всех узлов. Действует аналогично 
команде Edit>Mark>Unmark all главного меню. 

 «Options» - вызывает диалоговое окно настроек «tree options». Действует 
аналогично команде Edit>Mark>Options главного меню. 

 «Image creation» - добавить диаграмму отображения матрицы экспрессии. 
  
3.10.1. Диалоговое окно «find node setup» вызывается командой 
Edit>Mark>Mark nodes и предназначено для задания параметров выделения 
узлов.  В данной версии окно неактивно. 

3.10.1.1. Опция «Mark by leaf name». Если опция задана, выделение узлов 
производится по имени листа, которое задается в текстовом поле. 

3.10.1.2. Опция «Mark by distanse range». Если опция задана, выделение узлов 
производится по заданному диапазону расстояний. 

Кнопки управления диалоговым окном: 
• «Cancel»- выход без задания параметров. 
• «ОК» - выход с заданием параметров. 

3.10.2. Диалоговое окно “pattern setup” вызывается командой Image>Image setup и 
предназначено для настройки отображения матрицы экспрессии. 

3.10.2.1. Список палитр “Palette type” содержит следующие палитры цветов: 
3.10.2.1.1. “White(min)->Colormax” – цвет ячеек с увеличением значений в 

них изменяется от белого до максимально насыщенного цвета, 
заданного на панели 3.10.2.4. 

3.10.2.1.2. «Black(min)->Colormax» ” – цвет ячеек с увеличением значений 
в них изменяется от черного до максимально насыщенного цвета, 
заданного на панели 3.10.2.4. 

3.10.2.1.3. «Colormin->White->Colormax” – цвет ячеек с увеличением 
значений в них изменяется от минимально насыщенного цвета, 
заданного на панели 3.10.2.5 до максимально насыщенного цвета, 
заданного на панели 3.10.2.4. Цвет ячеек с «промежуточными» 
значениями белый. 

3.10.2.1.4. «Colormin->Black->Colormax»– цвет ячеек с увеличением 
значений в них изменяется от минимально насыщенного цвета, 
заданного на панели 3.10.2.5 до максимально насыщенного цвета, 
заданного на панели 3.10.2.4. Цвет ячеек с «промежуточными» 
значениями черный. 

3.10.2.1.5. «Geographic map colors» - палитра географической карты. 
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3.10.2.2. Список выбора типов диапазонов “Range type” в данной версии 
неактивен. 

3.10.2.3. Флаг “Field specific ranges” в данной версии неактивен. 
3.10.2.4. Панель “Max. value color” служит для задания цвета максимальной 

величины. Используется для палитр 3.10.2.1.1, 3.10.2.1.2, 3.10.2.1.3 и 
3.10.2.1.4. Кнопка “Color” вызывает диалоговое окно “Color chooser 
dialog”, с помощью которого можно установить нужный цвет. 
Выбранный цвет отображается на панели предварительного 
просмотра “Preview”. 

3.10.2.5. Панель “Min. value color” служит для задания цвета минимальной 
величины. Используется для палитр 3.10.2.1.3 и 3.10.2.1.4. Кнопка 
“Color” вызывает диалоговое окно “Color chooser dialog”, с помощью 
которого можно установить нужный цвет. Выбранный цвет 
отображается на панели предварительного просмотра “Preview”. 

3.10.2.6. Поле “Dataset max & min” служит для отображения максимальной и 
минимальной величины ячеек матрицы экспрессии: 

3.10.2.6.1. Поле “Max. value” отображает максимальную величину. 
3.10.2.6.2. Поле “Min. value” отображает минимальную величину. 

3.10.2.7. Поле “User defined values” в данной версии неактивно. 
3.10.2.8. Список “Number of intervals” – предназначен для выбора количества 

интервалов для расчета градаций цвета палитр. 
Кнопки управления диалоговым окном: 
• «Cancel»- выход без применения настроек. 
• «ОК» - выход с применением настроек. 

В строке статуса отображается информация о ячейке матрицы экспрессии, на 
которую наведен курсор: номер гена в таблице, идентификатор гена, номер поля в 
таблице, идентификатор поля и значение эксперимента. 

3.11. Кластеризация генов 
Команда Analysis>Clustering>Find genes’s clustering - вызывает диалоговое окно 

«setup for clustering procedure», в котором устанавливаются значения параметров 
запроса для кластеризации. 

Задание параметров кластеризации. 
3.11.1. Кнопка «Fields...» вызывает диалоговое окно выбора полей 3.3. 

Текстовое поле отображает количество выбранных полей. 
3.11.2. Список «Distance type» содержит три типа мер расстояний, которые 

вычисляются на основе коэффициентов корреляции Rij:  
• 1-Rij  
• 1+Rij  
• 1-|Rij| 

3.11.3. Список «Correlation type» содержит три типа коэффициентов 
корреляции:  

• Pearson r – коэффициент корреляции Пирсона.  
• Spearman r – коэффициент корреляции Спирмана.  
• Kendall tau – коэффициент корреляции Кендалла. 

3.11.4. Поле ввода порога кластеризации «Distance threshold». Гены 
объединяются в один кластер, если расстояние между ними меньше заданного 
порога. 

После нажатия кнопки «Clustering» производится кластеризация. Ее 
результаты отображаются в правой части диалогового окна.  
 

Работа с результатами кластеризации. 
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3.11.5. Список «Cluster #, size, score» содержит полученные кластеры. В нем 
приводится номер кластера, его размер, его вес.  

3.11.6. Список «Gene NAME, cluster index, gene score» содержит гены, 
принадлежащие выделенным в списке 3.11.5 кластерам. Приводится 
идентификатор гена и его вес. 

3.11.7. Список «Sort clusters by:» содержит параметры сортировки 
кластеров: 

• ascending index – сортировка по увеличению индекса (номера 
кластера) 

• r-score – сортировка по весу 
• size – сортировка по размеру 

3.11.8. Поле «Find gene by name» служит для поиска гена в списке 3.11.6 по 
его идентификатору. Для этого нужно ввести идентификатор (имя) гена и нажать 
кнопку «Find». Если ген находится в списке, он выделяется. Если нет, то выдается 
сообщение «Not Clustered!». 

Настройки выхода из окна 
3.11.9. Флаг «Build tree for selected genes». Если флаг установлен, при 

выходе из диалогового окна (после нажатия кнопки «OK, Exit») строится дерево 
для генов, принадлежащих кластерам, помеченным в списке 3.11.5.  

3.11.10. Флаг «Save selected data», поле «File name» и кнопка «Browse» в 
данной версии неактивны. 

3.11.11. Опция «Add cluster info for current data». Если опция задана, при 
выходе из панели (после нажатия кнопки «OK, Exit») результаты кластеризации 
заносятся в четыре новых поля, которые имеют названия: 

• ~TXT_n - номер кластера для каждого гена 
• ~TXT_size - размер кластера для каждого гена 
• ~TXT_Raver - вес кластера для каждого гена 
• ~TXT_Rcard - вес для гена,  
где TXT- текстовая строка, введенная в поле «Fields name».  
По умолчанию каждый раз при запуске диалогового окна присваивается  

TXT=Cl#, где # - очередной номер запуска диалогового окна. Если поля с таким 
именем уже существуют, они обновляются, если нет - создаются.  

Таблица с записанными в нее результатами кластеризации добавляется в 
список сохраненных проектов. Имя таблицы - *.table. 

3.11.12. Опция «Do not add clustering info». Если задана, при выходе из 
панели (после нажатия кнопки «OK, Exit») результаты кластеризации не 
сохраняются. 

3.11.13. Кнопки управления диалоговым окном 
• «Cancel» - выход без выполнения операции кластеризации 
• «Clustering» - подсчет кластеризации с установленными параметрами и 

переход к работе с результатами кластеризации. В конце счета появляется 
информационная панель, которая выводит число кластеров и 
максимальный/минимальный размер.  

• «ОК, Exit» - завершение работы диалогового окна с дополнительными 
опциями. 

 

3.12. Анализ главных компонент 
Команда Analysis> Principal component - вызывает диалоговое окно «setup 

for principal component analysis». Оно предназначено для: 
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• Задания значений параметрам разложения ковариационной  или 
корреляционной матрицы на собственные значения (СЗ, eigenvalue) и 
собственные вектора (СВ, eigenvectors) 

• Отображения профилей собственных значений, коэффициентов СВ 
• Отображения проекций значений экспрессии генов на плоскости из 

различных пар СВ 
 Для выбранных полей вычисляются ковариационная/корреляционная 
матрица, ее собственные значения и собственные вектора. 
 3.12.1. Кнопка «Fields…» вызывает диалоговое окно выбора полей. 
Текстовое поле отображает количество выбранных полей.  

3.12.2. Список «Matrix type» содержит типы матрицы:  
• covariation - ковариационная 
• correlation - корреляционная  

3.12.3. Кнопки управления диалоговым окном 
• «Cancel» - отказ и выход без расчета. 
• «Calculate» - выполнение расчета и переход к этапу отображения 

результатов.  
После расчета в списках 3.12.4, 3.12.7, 3.12.8 появляются порядковые 

номера компонент от 1 до числа отобранных для анализа полей.  
• «OK» - выход после выполнения анализа.  

3.12.4. Список «Component plots» содержит компоненты (собственные 
вектора), пронумерованные в порядке убывания собственных значений. 

3.12.5. Кнопка «Mark All» в данной версии неактивна. 
3.12.6. Панель отображения суммы собственных значений для компонент, 

отобранных в списке «Component plots».  
• Текстовое поле «Variance» отображает сумму собственных значений 

компонент, выделенных в списке «Component plots». 
• Текстовое поле «Variance (%total)» отображает  долю суммы (%) собственных 

значений компонент, выделенных в списке «Component plots». 
• Кнопка «Eigenvalue plot» вызывает диалоговое окно «Graph», в котором 

отображаются значения выделенных компонент.  
• Кнопка «Loadings plot» вызывает диалоговое окно «Graph», в котором 

отображаются значения групп для каждой компоненты.  
• Кнопка «Save results» в данной версии неактивна. 

 
Построение проекций. 

3.12.7. «ComponentX» - содержит компоненты (собственные вектора), 
пронумерованные в порядке убывания собственных значений. Служит для выбора 
компоненты для оси абсцисс. 

3.12.8. «ComponentY» - содержит компоненты (собственные вектора), 
пронумерованные в порядке убывания собственных значений. Служит для выбора 
компоненты для оси ординат. 

Кнопка «Draw» выполняет построение диаграммы.  

3.13. Диалоговое окно профилей 
Диалоговое окно профилей диаграмм отображает профили экспрессии 

генов. В нем можно выделить три части: график, список генов, список групп полей. 
3.13.1. График 

В верхней части окна профилей над областью графика расположены 
кнопки, которые позволяют менять вид графического представления данных по 
результатам экспериментов: 
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• Кнопкой  устанавливает режим отображения данных в виде столбчатой 
диаграммы. 

• Кнопкой  устанавливает режим отображения данных в виде графика с 
маркерами данных.  

• Кнопкой  устанавливает режим отображения данных в виде графика.  
• Кнопкой  устанавливает режим отображения данных в виде точечной 

диаграммы.  
• Кнопка  устанавливает режим отображения на области диаграммы 

горизонтальных линий сетки,  
• Кнопка  устанавливает режим отображения на области диаграммы 

вертикальных линий сетки.  
• Кнопкой  можно сделать график псевдообъемным (этот режим работает 

только для столбчатой диаграммы).  
• Кнопка   вызывает диалоговое окно настройки опций.  
• Кнопка   добавляет в диаграмму профили максимальных и минимальных 

значений экспрессии. 
3.13.2. Информационная панель 

Информационная панель диалогового окна профилей располагается под 
областью диаграммы. Информация выводится в ней при наведении курсора на 
элемент графика (или щелчке на нем – в зависимости от текущих настроек). 
Вверху выводится имя гена, для которого отображены эксперименты. В правой 
колонке выводится информация о группе экспериментов, на которой стоит курсор. 
В левой колонке выводится информация об эксперименте, на который наведен 
курсор. Внизу выводится описание гена. 

3.13.3. Режимы отображения экспериментов 
Существует два режима отображения экспериментов: 

• Детализированный режим представления экспрессии гена. 
• Множественный режим представления экспрессии генов. 

Переключение этих режимов осуществляется в списке генов. 
При детализированном режиме представления экспрессии генов расцветка 

соответствующих элементов графика соответствует расцветке групп 
экспериментов. Над графиком выводятся максимальная и минимальная величины 
для всех групп экспериментов.  В верхней части графика расположен общий 
профиль гена по всем экспериментам. По оси ординат отложена величина 
экспрессии. По оси абсцисс отложены краткие имена экспериментов. 

При множественном режиме отображаются данные для одного и более 
генов. Расцветка соответствующих элементов графика соответствует расцветке 
генов. Над графиком выводятся максимальная и минимальная величины для всех 
групп экспериментов по всем генам списка. В верхней части графика расположена 
разметка групп экспериментов. Цвет разметки соответствует цвету группы 
экспериментов. Над данными расположен общий профиль генов по всем 
экспериментам. В режиме гистограммы данные для каждого эксперимента 
выводятся сериями и столбцы наполовину перекрываются. На переднем плане 
находится элемент (столбец) группы экспериментов того гена, который занимает 
верхнюю позицию в списке.  
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3.13.4. Список генов 
В правой верхней части диалогового окна экспрессии находится список генов. 

С помощью кнопок, расположенных слева от названий генов (цвет кнопки 
соответствует цвету гена), можно работать отдельно с каждым геном. У каждой 
кнопки есть две части. Квадратная часть кнопки – индикатор состояния 
(циклически переключается щелчком  мыши) и прямоугольная – рабочая. Эти 
кнопки позволяют: 

• Войти в детализированный режим отображения гена. Для этого надо 
нажать на рабочую часть кнопки. Кнопка при этом утопится. Одновременно 
может быть нажата только одна кнопка. 

• Множественный режим отображения установлен, если все кнопки 
находятся в отжатом (неутопленном) состоянии. Для перехода из 
детализированного режима во множественный нужно отжать кнопку того 
гена, для которого в данный момент включен детализированный режим 
отображения. 

• Включить режим отображения гена. Для этого надо щелкать по индикатору 
состояния кнопки до тех пор, пока на нем не появится черный квадрат 

. 
• Исключить ген из отображения. Для этого надо щелкать по индикатору 

состояния кнопки, до тех пор, пока на нем не появится белый квадрат 
. Если все гены исключены из отображения, то, область построения 

будет пустой. 
Для того чтобы поменять цвет отображения гена, нужно щелкнуть правой 

кнопкой мыши по рабочей части кнопки. В появившемся контекстном меню нужно 
выбрать команду «Set color», после чего с помощью диалогового окна выбора 
цвета можно установить нужный цвет. 

Над списком генов находятся кнопки, с помощью которых можно менять его 
параметры. Кнопка  служит для одновременного выключения из отображения 
всех генов. Кнопка  служит для одновременного включения режима 
отображения всех генов.  

3.13.5. Список групп экспериментов 
В правой нижней части диалогового окна экспрессии находится список групп 

экспериментов. С помощью кнопок, расположенных слева от подписей групп (цвет 
кнопки соответствует цвету отображения группы, которую регулирует кнопка) 
можно работать индивидуально с каждой группой. У каждой кнопки есть две части: 
квадратная часть - индикатор состояния и прямоугольная часть – рабочая. Если 
щелкать мышью по индикатору состояния, он циклически переключается. Эти 
кнопки позволяют: 

• Исключить из отображения группу. Для этого надо щелкать по индикатору 
состояния кнопки до появления на нем белого квадрата . 

• Отображать только минимальное и максимальное значения группы. Для 
этого надо щелкать индикатору состояния кнопки до появления на нем 
белого квадрата с черной окантовкой . 

• Отобразить элементы, выделенные в списке данной группы. Для этого надо 
щелкать по индикатору состояния кнопки до появления на нем серого 
квадрата с черной окантовкой . Вызов списка производится с 
помощью контекстного меню группы (см ниже).  

• Отобразить все элементы группы. Для этого надо щелкать по индикатору 
состояния кнопки до появления на нем черного квадрата . 
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• Включить режим отображения только конкретной группы. Для этого надо 
нажать на рабочую часть кнопки нужной группы. Кнопка при этом утопится, 
а в области построения будет выведена только выбранная группа.  
 
Для того чтобы вызвать контекстное меню группы, требуется щелкнуть 

мышью по рабочей части кнопки нужной группы.  
Для того чтобы выделить элементы в списке отображаемых элементов 

группы, надо выбрать команду «Select elements» контекстного меню группы. После 
этого откроется окно со списком элементов группы. В списке необходимо отметить 
мышью нужные элементы. Для этого требуется щелкнуть мышью на индикаторе 
состояния, расположенном слева от названия элемента. Если на индикаторе 
появился черный квадрат, элемент выбран для отображения, иначе – выключен 
из отображения. Кнопкой  можно выделить сразу все элементы списка. Кнопкой 

 можно снять выделение со всех элементов списка. Для подтверждения 
выбора надо нажать кнопку «OK». Выбранный набор элементов для отображения 
действителен только для режима отображения экспериментов по списку. 

Для того чтобы поменять цвет отображения группы, нужно выбрать в 
контекстном меню команду «Set color» контекстного меню группы. В появившемся 
диалоговом окне выбора цвета можно задать желаемый цвет.  

Над списком групп находится ряд кнопок, с помощью которых можно менять 
параметры отображения всех групп экспериментов. Кнопка  служит для 
одновременного выключения из отображения всех групп. Кнопка , служит для 
одновременного включения режима отображения минимума и максимума для 
всех групп. Кнопка , служит для одновременного включения режима 
отображения отмеченных в списках элементов групп для всех групп. Кнопка , 
служит для одновременного включения режима отображения всех элементов для 
всех групп.  


